Chapter 12 Applications: Terrain Mapping and Analysis

The applications section includes six tasks. Task 1 uses DEM data for terrain mapping and analysis. To create a 3D perspective view in Task 1, you will use ArcScene, accessible through the 3D Analyst extension. Tasks 2 and 3 perform viewshed analysis, first with two given lookout locations and then with three lookout locations of your choice. Tasks 4 and 5 let you work with TINs in ArcMap: you will build and modify a TIN in Task 4, and derive a slope map from the TIN in Task 5. In Task 6, you will build a TIN in ArcInfo Workstation and derive a slope and aspect maps from the TIN. 

Task 1: Use DEM for Terrain Mapping and Analysis 

What you need: plne, an elevation grid; streams.shp, a stream shapefile. 

The elevation grid plne is imported from a USGS 7.5-minute DEM. The shapefile streams.shp shows major streams in the study area. Task 1 covers terrain mapping and analysis using Spatial Analyst and 3D Analyst in ArcMap.

Create a Contour Map

1 Start ArcCatalog, and make connection to the Chapter 12 database. Launch ArcMap. Add plne to Layers, and rename Layers Task 1. Select Extensions from the Tools menu and check the boxes for Spatial Analyst and 3D Analyst. Then click the View menu, point to Toolbars, and make sure that the boxes for Spatial Analyst and 3D Analyst are both checked. 
2 Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Contour. In the Contour dialog, select plne for the Input surface, enter 100 (meters) as the Contour interval and 800 (meters) as the Base contour, and save the Output features as ctour.shp. Click OK to dismiss the dialog. 

3 Ctour.shp appears on the map. Do the following to label the contour lines. Select Properties from the context menu of ctour. Under the Labels tab, check the box to Label Features in this layer and select CONTOUR from the Label Field dropdown list. Click OK to dismiss the dialog. The contour lines are now labeled. (To remove the contour labels, right-click ctour and uncheck Label Features.)

Create a Vertical Profile

1 Add streams.shp to Task 1. Select Open Attribute Table from the context menu of streams. Click the Options dropdown arrow and choose Select by Attributes. Enter the following SQL statement in the expression box: “USGH_ID” = 167. Click Apply. Close the streams attribute table. Use the Zoom In tool to zoom in the selected stream.

2 Make sure that the 3D Analyst toolbar is available. Click the Interpolate Line tool on the 3D Analyst toolbar. Use the mouse pointer to digitize points along the selected stream. Double-click the last point to finish digitizing. A rectangle with handles appears around the digitized stream. 

3 Click the Create Profile Graph tool on the 3D Analyst toolbar. A vertical profile appears with a default title and subtitle. Right-click the title bar of the graph and select Properties. The Graph Properties dialog allows you to enter a new title and subtitle and to choose other advanced design options. 

4 The digitized stream becomes a graphic element on the map. You can delete it by first selecting it using the Select Elements tool. To unselect the stream, choose Clear Selected Features from the Selection menu.

Create a Hillshade Map

1 Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Hillshade. In the Hillshade dialog, select plne for the Input surface. Take the default values of 315 for Azimuth, 45 for Altitude, 1 for Z factor, and 30 for Output cell size. Opt for a Temporary Output raster. Click OK to dismiss the dialog. Hillshade of plne is added to the Table of Contents. 

2 Try different values of azimuth and altitude to see how these two parameters affect hill shading. For example, a hillshade map will look darker with a lower altitude.

Create a 3D Perspective View

1. Make sure that the 3D Analyst toolbar is available. Click the ArcScene tool on the 3D Analyst toolbar. The ArcScene application opens. Add plne and stream.shp to view. By default, plne is displayed in a planimetric view, without the 3D effect. Select Properties from the context menu of plne. Click the Base Heights tab. Click the radio button next to “Obtain heights for layer from surface,” and select plne for the surface. Click OK to dismiss the dialog. 

2. Plne is now displayed in a 3D perspective view. The next step is to superimpose streams on the surface. Select Properties from the context menu of streams. Click the Base Heights tab. Click the radio button next to “Obtain heights for layer from surface,” and select plne for the surface. Click OK to dismiss the dialog. 

3. Using the properties of plne and streams, you can change the look of the 3D view. For example, you can change the color scheme for displaying plne. Select Properties from the context menu of plne. Click the Symbology tab. Right-click the Color Ramp box and uncheck Graphic View. Click the Color Ramp dropdown arrow and select Elevation #1. Click OK. Elevation #1 uses the conventional color scheme to display the 3D view of plne. Click the symbol for streams in the Table of Contents. Select the River symbol from the Symbol Selector, and click OK. 

4. You can tone down the color symbols for plne so that streams can stand out more. Select Properties from the context menu of plne. Click the Display tab, enter 40 (%) in the box next to Transparent, and click OK. 

5. The 3D Analyst toolbar has tools for you to navigate, zoom in or out, center on target, zoom to target, and to perform other manipulations. For example, the navigate tool allows you to rotate the 3D surface. Exit ArcScene when you are done. 

Create a Slope Map

1. Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Slope. In the Slope dialog, select plne for Input surface and opt for a temporary Output raster. 

2. Slope of plne shows a degree slope map in a default classification. Select Properties from the context menu of Slope of plne. Click the Symbology tab, and click Classify. Click the Classes dropdown arrow and change the number of classes from 9 to 5. Click the first cell under Break Values, and enter 10. Enter 20, 30, 40, and 53 in the next four cells. Click OK to dismiss the dialog. The slope map now has a new classification.

3. Reclassify in the Spatial Analyst dropdown list can also be used for re-classification. The difference is that Reclassify creates a new integer grid based on the new classification.

Create an Aspect Map

1. Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Aspect. In the Aspect dialog, select plne for Input surface and opt for a temporary Output raster. Click OK to dismiss the dialog. 

2. Aspect of plne shows an aspect map with eight principal directions and flat area. But the aspect grid is actually a floating-point grid and does not have an attribute table. You can use Reclassify to convert the aspect grid to an integer grid or to change the aspect classification, for example, from the eight to four principal directions.

3. Select Reclassify from the Spatial Analyst dropdown list. Select Aspect of plne for the Input raster. Click Classify. Select a different method than Manual from the Method dropdown list to activate Classes. Click the Classes dropdown arrow and choose 9. Click the first cell under Break Values and enter –1. Enter 22.5, 67.5, 112.5, 157.5, 202.5, 247.5, 292.5, 337.5, and 360 in the following nine cells. Click OK to dismiss the dialog. 

4. Old values in the Reclassify dialog are now updated with the break values you have entered. Now you have to change new values. Click the first cell under New values and enter –1. Click and enter 1, 2, 3, 4, 5, 6, 7, 8, and 1 in the following 9 cells. The last cell has a value of 1 because the cell (337.5-3600) and the second cell (-1-22.50) make up the north aspect. Click OK to dismiss the ReClassify dialog. Reclass of Aspect of plne is an integer aspect grid with the eight principal directions and flat (-1). 

Task 2:. Perform Viewshed Analysis

What you need: plne, an elevation grid; and lookouts.shp, a lookout location shapefile.

The elevation grid plne is the same as for Task 1. The lookout location shapefile contains two points, labeled 1 and 2. A viewshed analysis can determine areas in plne that are visible from the two lookout locations and areas that are not visible. To better visualize the relationship between visibility and terrain, you will also use a hillshade map of plne.  

1. Select Data Frame from the Insert menu in ArcMap. Rename the new data frame Tasks 2&3, and add plne and lookouts.shp to Tasks 2&3. First, create a hillshade map of plne. Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Hillshade. Select plne for the input surface and take the default values for the other parameters. Click OK to dismiss the dialog. Hillshade of plne is added to the map.  

2. Now you will run a viewshed analysis. Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Viewshed. Make sure that the Input surface is plne and Observer points are from lookouts. Opt for a temporary Output raster. Click OK to dismiss the Viewshed dialog.  

3. Viewshed of lookouts separates the visible areas from not visible areas. Portions of the visible area are visible to only one observer point, while others are visible to both observer points. Right-click Viewshed of lookouts and select Properties. Under the Symbology tab, click Unique Values in the Show box. Under the Display tab, enter 50 next to Transparent. Click OK to dismiss the dialog. Viewshed of lookouts now shows three classes: 0 for not visible, 1 for visible from one observer point, and 2 for visible from both observer points. 

4. Right-click Viewshed of lookouts and select Open Attribute Table. The table shows cell counts for the three classes of 0, 1, and 2. 

Task 3: Create a New Lookout Shapefile for Viewshed Analysis

What you need: plne and lookouts.shp, same as Task 2.

Task 3 asks you to digitize three new lookout locations before running a viewshed analysis. 

1. Select Copy from the context menu of lookouts. Select Paste Layer from the context menu of Tasks 2&3. The copied shapefile is also named as lookouts. Right-click the first lookouts in the Table of Contents, and select Properties. Under the General tab, change Layer Name from lookouts to newpoints. Newpoints contains two observer points from lookouts, which will be removed in this task and replaced with three new observer points. 

2. Click the Editor Toolbar button to open the Editor toolbar. Click the Editor menu and select Start Editing. Make sure that the Task is to Create New Feature and the Target is newpoints. Click the Edit tool on the Editor toolbar. Click an observer point in newpoints. When the point is shown in cyan, delete it. Click the other observer point and delete it. 

3. Next add new observer points. To find suitable observer point locations, you can use Hillshade of plne as a guide and the Zoom In tool for close-up looks. You can also use plne and the Identify tool to find elevation data. When you are ready to add an observer point, click the Create New Feature tool first and then click the intended location of the observer point. Add two more observer points. Click the Editor menu and select Stop Editing. Save the edits. You are ready to use newpoints for viewshed analysis.

4. Click the Spatial Analyst dropdown arrow, point to Surface Analysis, and select Viewshed. Make sure that Input surface is plne and Observer points are from newpoints. Opt for a temporary Output raster. Click OK to dismiss the dialog.

5. Viewshed of newpoints shows visible and not visible areas. The attribute table of Viewshed of newpoints provides cell counts of visible from one point, visible from two points, and visible from three points. 

6. To save newpoints as a shapefile, you can right-click newpoints, point to Data, and select Export Data. In the Export Data dialog, specify the path and name of the output shapefile. 

Task 4: Build and Display a TIN in ArcMap

What you need: emidalat, an elevation grid; and emidastrm.shp, a stream shapefile 

Task 4 shows you how to construct a TIN from an elevation grid and to modify the TIN with emidastrm.shp as breaklines. You will also display different features of the TIN.

1. Select Data Frame from the Insert menu in ArcMap. Rename the new data frame Tasks 4&5, and add emidalat and emidastrm.shp to Tasks 4&5.

2. Make sure that the 3D Analyst toolbar is available. Click the 3D Analyst menu, point to Convert, and select Raster to TIN. In the Convert Raster to TIN dialog, make sure that emidalat is the Input raster. Enter 10 as the Z tolerance. Specify the Output TIN as emidatin. Click OK to dismiss the dialog.

3. Emidatin is added to the map. The next step is to modify emidatin with emidastrm, which contains streams. Click the 3D Analyst menu, point to Create/Modify TIN, and select Add Features to TIN. In the Add Features to TIN dialog, make sure that emidatin is the Input TIN. Check emidastrm in the Layers box. Then select None for the Height source and Triangulate as hard line. Click OK to dismiss the dialog. 

4. You can view emidatin in a variety of ways. Select Properties from the context menu of emidatin. Click the Symbology tab. Click the Add button below the Show frame. An Add Renderer scroll list appears with choices related to the display of edges, faces, or nodes that make up emidatin. Click Faces with the same symbol in the list, click Add, and click Dismiss. Uncheck all the boxes in the Show frame except Faces. Make sure that the box to show hillshade illumination effect in 2D display is checked. Click OK on the Layer Properties dialog. With its faces in the same symbol, emidatin can be used as a background in the same way as a hillshade map for displaying map features such as streams, vegetation, and so on. 

Task 5: Convert a TIN to a Slope Shapefile in ArcMap

What you need: emidatin, a TIN created in Task 4.  

Task 5 shows you how to convert a TIN to a slope shapefile. You can use the same method to convert a TIN to an aspect shapefile. 

1. To use slopes of a TIN in data analysis with other vector data, you must first display the TIN in the slope classes you want and then convert the TIN to a polygon shapefile. Select Properties from the context menu of emidatin. Click the Symbology tab. Click the Add button. Select “Face slope with graduated color ramp” from the Add Renderer scroll. Click Add and then Dismiss.

2. In the Layer Properties dialog, make sure that Slope is checked and others are unchecked in the Show frame. Then click (highlight) Slope in the Show frame so that the description under the Symbology reads: Face slope with graduated color ramp. Symbols for the default slope classes appear. You need to change the number of classes and their ranges. Click Classify. Select 6 from the Classes dropdown list. Click the first cell under Break Values and enter 10. (You may have to enter 10 more than once.) Then enter 20, 30, 40, and 50 in the next four cells. Click the empty space in the Break Values box to unselect. Click OK to dismiss the dialog. The slope classes you have entered are now displayed in the Symbology tab. Click OK to dismiss the Layer Properties dialog. 

3. Clip the 3D Analyst dropdown arrow, point to Convert, and select TIN to Features. Make sure that emidatin is the Input TIN. Click the Conversion dropdown arrow and select “triangles classified by slope to polygons.” Specify the Output features to be saved as tinslope.shp. Click OK to dismiss the dialog. 

4. Select Open Attribute Table from the context menu of tinslope. The field SlopeCode shows the slope class for each polygon. You can also use SlopeCode as the Value and display tinslope using Graduated colors. 

Task 6: Process TIN in ArcInfo Workstation

What you need: emidalat, an elevation grid; and breakstrm, a stream coverage

In Task 6, you will build a TIN from emidalat and breakstrm in ArcInfo Workstation using the VIP algorithm and derive slope and aspect maps from the TIN as polygon coverages. 

1. The VIP algorithm selects "very important" points from an elevation grid to be included in a TIN. ARC/INFO allows users to specify a percentage of elevation points to be selected. The default is 10%. 

Arc: vip emidalat emidavip  /*emidavip is the output point coverage

2. The CREATETIN command in ARC/INFO can create a TIN using data from different sources. For this task, you will use two data sources: (1) elevation points selected by the VIP algorithm and (2) the hard breakline of emidastrm. Elevation along streams in emidastrm will be derived from the elevation grid emidalat. CREATETIN is a dialog command. You will use subcommands in the dialog to enter the input data.

Arc: createtin emidatin2    /* emidatin2 is the output tin

      : cover emidavip point   /* input elevation points from emidavip

      : lattice emidalat breakstrm line hardline  /* input emidastrm as hardline

      :end    /* exit createtin

3. The next step is convert emidatin2 to a polygon coverage. Each triangle in emidatin2 becomes a polygon with its slope and aspect measures. Slopes can be measured in percent or degrees.

Arc: tinarc emidatin2 emidapoly poly percent  /*emidapoly is the polygon coverage

4. Emidapoly contains the items of percent slope and aspect. Typically, percent slope values are grouped into classes so that slopecode 1 = 0-20%, slopecode 2 = 20-40%, and so on. After the slope classification is completed, emidapoly can be dissolved into a slope (polygon) map by using slopecode as the dissolve item. Likewise, emidapoly can be dissolved into an aspect (polygon) map by using aspectcode as the dissolve item. The following shows the command to dissolve emidapoly into a slope map called emidaslope:

Arc: dissolve emidapoly emidaslope slopecode poly

